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4D SYSTEMS Workshop 4 User Guide

1. Description

This user guide provides an introduction to Workshop 4, the 4D Systems integrated development environment.

Workshop 4 supports multiple development environments for the user, to cater for different user
requirements and skill level.

The Designer environment enables the user to write 4DGL code in its natural form to
program the 4D Systems module of choice.

A visual programming experience, suitably called ViSi, enables drag-and-drop type
placement of objects to assist with 4DGL code generation and allows the user to visualise
how the display will look while being developed.

An advanced environment called ViSi-Genie doesn’t require any 4DGL coding at all, it is all
done automatically. Simply lay the display out with the objects required, set the events to
drive them and the code is written for the user automatically. ViSi-Genie provides the
Vic il eni'e latest rapid development experience from 4D Systems. (Not available for Goldelox)
M e ese—

A Serial environment is also provided to transform the 4D Systems module into a slave
serial module, allowing the user to control the display from any host microcontroller or
device with a serial port.

Serial
\ T ——

To install Workshop 4, please refer to the document Workshop 4 Installation.

\V)
O
J
]
| -
v
n
=
T
Q
@]
L
n
Y
| -
=

© 2013 4D SYSTEMS Page 4 of 37 www.4dsystems.com.au




4D SYSTEMS Workshop 4 User Guide

2. Workshop 4

There is an alias for 4D Workshop on the desktop:

7 € O RS me X W &

Launch 4D Workshop by double-clicking on the icon:

workshop
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40 SYSTEMS Workshop 4 User Guide

. Create a New P

Workshop 4 opens and displays the Recent page:

=15 Workshop 4 - NoName2(uLCD-32PT, LANDSCAPE) (=[5 [ |
m Home | View Tools Widgets Comms Project a

Recent
\ | open SOUNDPLAYER.4DGenie 14/09/2012 12:32 p.m.
E C:\ProgramData\Documents\4D Labs\PICASO Visi
Genie\SOUNDPLAYER\SOUNDPLAYER.4DGenie
FANCYBUTTONS.4DVisi 21/12/2011 1:30 pm.
save
Notamet® \ProgramData\Documents\4D Labs\PICASO 4D-

Visi\FANCYBUTTONS.4DViS

IMAGECONTROLKBD.4DG 22/10/20123:42 pum.
I o ICASO0- MAGE
CCONTROL\IMAGECONTROLKBDADG
‘[.H Zip Project BUFFEREDTX.4DG 6/06/2010 1:33 a.m.

m C:\ProgramData\Documents\4D Labs|\PICASO GFX2\PICASO - SERIAL

Y MM IFFEREDTX.4(
e WORKSHOP  vesionioz: ERES
C:\ProgramData\Documents\4D Labs\PICASO GFX2\PICASO - SERIAL
4DG

COMCHECK.4DG §/06/2010 1:41 am.
& Print Setup
COMMS\COMCHECK::

‘ D Create a new Project SLIDETRACK.4DViSi 8/11/2012 1:50 p.m.
Start building a new Visi, Genie, Designer

or Serial program C:\ProgramData\Documents\4D Labs\Picaso Visi\SLIDETRACKADVIS

b
~.$’ ORI SWITCHANDKNOB.4DVisi 11/11/2011 5:52 p.m.
ers\Public\Documents\4D Labs\Piaso
@ Help Visi\SWITCHANDKNOB.40ViS

MP3-Player.4DViSi

@ e Create a new Project M.

Start building a new program using the
same settings as you last used (Visi

x or 4 uLCD-32PT) FANCYBUTTONS.4DViSi

ProgramData\Documents\4D Labs\picaso
i\FANCYBUTTONS.4DViS|

4/11/2012 1:34 p.m.

abs\Picaso Visi\MP3-F

21/12/2011 1:30 p.m.

MP3-Player.4DVisi 4/11/2012 1:34 p.m.

To create a new program, there are multiple options:

e  Click on the top left-most icon New
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40 SYSTEMS Workshop 4 User Guide

e C(Click on the upper Create a New Project if creating a project from scratch, or click on the lower Create

a New Project to use the settings and module that was used last time:

Wo R KS H 0 P Version 4.0.2.1

Create a new Project

Start building a new Visi, Genie, Designer or
Serial program

Create a new Project
Start building a new program using the same
settings as you last used (Visi-Genie
uLCD-32PT)

Choose Your Product, simply select the 4D Systems module of choice to start your development:

CHOOSE YOUR PRODUCT

POLED-96-G2
l 0.96" Intelligent OLED module

HOLED-128-G2 128x128
1.5" Intelligent OLED module

HOLED-160-G2
1.7" Intelligent OLED module

HLCD-144-G2 128x128
1.44" IntelligentLCD Module

\V)
O
J
]
| -
v
n
=
J
Q
@]
L
n
Y
| -
=

HLCD-24PTU 240x320
2.4"QVGA Intelligent Touch Screen LCD Module

HLCD-28PT 240x320
2.8"QVGA Intelligent Touch Screen LCD Module

I HLCD-24PT 240x320
2.4"QVGA Intelligent Touch Screen LCD Module

Select the product, in this case the pLCD-32PT Display Module:

4 pLCD-32PT 240x320
3.2"QWGA Intelligent Touch Screen LCD Module

|

D

© 2013 4D SYSTEMS Page 7 of 37 www.4dsystems.com.au




40 SYSTEMS Workshop 4 User Guide

The selected module is displayed on the right hand side:

CHOOSE YOUR PRODUCT

HLCD-24PT 240x320
2.4" QVGA Intelligent Touch Screen LCD Module

pLCD-24PTU 240x320
. 2.4"QVGA Intelligent Touch Screen LCD Module

HLCD-28PT 240x320
2.8" QVGA Intelligent Touch Screen LCD Module

pLCD-28PTU 240x320
. 2.8" QVGA Intelligent Touch Screen LCD Module

19} ©

" pLCD-32032-P1 240x320
3.2"QVGA Intelligent Touch Screen LCD Module

Portrait (Click image to rotate)

PLCD-32PT 240x320
3.2"QVGA Intelligent Touch Screen LCD Module

pLCD-32PTU 240x320 |
. 3.2"QVGA Intelligent Touch Screen LCD Module v/—\

Orientation is portrait by default.

To set it to landscape, just click on the image of the display to rotate it. Additional clicks rotate the display by
90 degrees:

CHOOSE YOUR PRODUCT

PLCD-24PT 240x320
2.4" QVGA Intelligent Touch Screen LCD Module

HLCD-24PTU 240x320
2.4"QVGA Intelligent Touch Screen LCD Module

pLCD-28PT 240x320
2.8"QVGA Intelligent Touch Screen LCD Module
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HLCD-28PTU 240x320
2.8"QVGA Intelligent Touch Screen LCD Module

|

* pLCD-32032-P1 240x320
3.2"QVGA Intelligent Touch Screen LCD Module

pLCD-32PT 240x320
3.2"QVGA Intelligent Touch Screen LCD Module

HLCD-32PTU 240x320 .
. 3.2"QVGA Intelligent Touch Screen LCD Module

Press Next to proceed:

© 2013 4D SYSTEMS Page 8 of 37 www.4dsystems.com.au
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40 SYSTEMS Workshop 4 User Guide

4. Choose Your Environment

The main window now asks for the environment for the project:

Workshop 4

CHOOSE YOUR ENVIRONMENT g

File

Designer

The Designer environment enables the user to write 4DGL code in its A visual programming experience, suitably called ViSi, enables drag and

natural form to program the display module. drop type placement of objects to assist with 4DGL code generation and
allows the user to visualise how the display will look while being
developed.

| Visi Genie | serial

An advanced environment called ViSi-Genie doesn't require any 4DGL A Serial environment is also provided to transform the display into a slave
coding at all, it is all done for you. Simply lay the display out with the serial module, allowing the user to control the display from any host
objects you want, set the events to drive them and the code is written for microcontroller or device with a serial port.

'you automatically. ViSi-Genie provides the latest rapid development

experience from 4D Systems.

Four main environment options are available:

e Designer,

e ViSi,
e ViSi-Genie,
e  Serial

...and two editor options:
o  Create System File,

e (Create Text File.

Each option opens a customised environment with specific commands and controls.

Different projects using different modules and environments can be open simultaneously on Workshop 4. The
toolbar ribbon will adapt to the project tab that is selected, to suit its environment.

© 2013 4D SYSTEMS Page 9 of 37 www.4dsystems.com.au
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4.1. Designer

Designer

The Designer environment enables the user to write 4DGL code in its
natural form to program the display module.

The Designer environment enables the user to write 4DGL code in its natural form to program the display
module. 4DGL is a graphics oriented language allowing rapid application development, and the syntax structure
was designed using elements of popular languages such as C, Basic, Pascal and others.

| s orl p 4 - NoNamel*(uLCD-32P

Home Tools Comms Project

| New [g]saveas 03, i Copy & undo < \ @ @ <) f)\ @ @ % — Collapseal & Compile
|l open = Print Biraste | & Redo "6 "6 ) d &3 comp'nLoad
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= Bxpand All
Cut Clear All Next Prev Set Find Replace Goto Find Again
[ sove R pelste ) ;
File Clipboard Undo/... Bookmarks Find Code Felding Compile
qb
vz [ o |« fbne i N o 51N
1 |#platform "uLCD-32PT_GFX2"
w2 ||// Designez
3 |#inherit "4DGL_lébitColours.fnc"”
5 |func main()
gfx_ScreenMode (LANDSCAPE) ; // change manually i1f orientation change
9 print ("Hello World") ; // replace vith your code
11 repeat // maybe replace
1 forever // this as well
14 |endfunc
Insert Line:2 Col:8

To learn more about Designer, please to refer to the 4DGL Internal Functions Reference Manuals and 4DGL
Programmers Reference Manual on the Workshop 4 product page of the website, and the related application
notes on the Application Note page of the website. http://www.4dsystems.com.au
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4.2. ViSi

A visual programming experience, suitably called ViSi, enables drag and
drop type placement of objects to assist with 4DGL code generation
and allows the user to visualise how the display will look while being
developed.

A visual programming experience, suitably called ViSi, enables drag-and-drop type placement of objects to
assist with 4DGL code generation and allows the user to visualise how the display will look while being
developed.

op 4 - NoName2*(uLCD-32PT, LANDSCAP|

Home View Tools Widgets Comms Project

| New [g]saveas 03, i Copy & undo < \ @ @ < b ’)\ @ @ /“Q _ '—' & compile
|| open & Print Biraste | & Redo ’é - é b J e — = &3 Comp'nLoad
Cut ClearAll Nedt Prev  Set Find Replace Goto Find Again | Collapsedl Bxpand Al

[ save R
File

Delete
Clipboard Undo... Bookmarks Find

0] N mroneme- = [1EH B B =

1 |#platform "uLCD-32PT_GFX2"
2 /7 visi
5 |// Program Skeleton 1.0 gensrated 12/10/2012 12:23:21

Code Folding Compile

Iy

#inherit "4DGL_l6bitColours.fnc”

m

#inherit "VisualConst.inc"
' |#inherit "NoName2Const.inc"

fune main(}
12 |// var nstrings : // Handle to access uSD strings, uncomment if required
3 |// var hFentx ; // Handle to a
#/ Uncomment the following if uSD images

15 e

s fonts, uncol

if requirsd an
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fonts or strings used.

putstr{"Mounting...\n"); Object Inspector
if (!(disk:=file )
wnils(!(disk :=file Mount())) Form [Forml vl
utstr("Drive not mounted..."):
s putstr("Drive not mounted ) Object [mel v]
20 pauss (200) ; S
" = b | || Properties | Paste Code | [Paste all Code
Name Form1
Bgtype Color
Color WsLack
Image one)
[ source
Insert Linel Coll

To learn more about ViSi, please to refer to the ViSi User Guide on the Workshop 4 product page of the
website, and the related application notes on the Application Note page of the website.
http://www.4dsystems.com.au
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4.3. ViSi-Genie

ViSi Genie

An advanced environment called ViSi-Genie doesn't require any 4DGL
coding at all, itis all done for you. Simply lay the display out with the
objects you want, set the events to drive them and the code is written
for you automatically. ViSi-Genie provides the latest rapid development
experience from 4D Systems.

An advanced environment called ViSi-Genie doesn’t require any 4DGL coding at all, it is all done for the user. By
simply laying the display out with the wanted objects and setting the events to drive them, the code is written
automatically. ViSi-Genie provides the latest apid development experience from 4D Systems.

Project

n ‘ — | g, [Bwmons (Dot Gages (pmives (Inputs lsbek | Syctemmeda [Ty
B U b @ E— 1
N 0 Save SaveAs Print | Build D ’ [ J )
ew  Open Sove SaveAs Prnt  Sui @ |
File Build
- qn
[E x| \-{ [xI™ [liNoNames X1 [ =] \[ =,
Formd 52| | Object Ispector B
Form IFormU v]
Object [Forma =)

Properties |Events
Name Formi)
Batype Color
Color WsLack
Image one]
Source
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Insert Line:l Coll

To learn more about ViSi-Genie, please to refer to ViSi-Genie User Guide on the Workshop 4 product page of
the website, and the related application notes on the Application Note page of the website.
http://www.4dsystems.com.au
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4.4, Serial

A Serial environment is also provided to transform the display into a slave
serial module, allowing the user to control the display from any host
microcontroller or device with a serial port.

The Serial environment is provided to transform the module into a slave serial module, allowing
communication and control from virtually any host micro-controller or device with a serial port.

For detail on this environment and steps on how to make your display module run under the Serial
environment, please refer to the Serial Command Set Reference Manual on the Workshop 4 product page of
the website, and the related application notes on the Application Note page of the website.
http://www.4dsystems.com.au
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4D SYSTEMS

Workshop 4 User Guide

4.5. Create System File

The Create System File option provides an editor for all 4DGL-related projects, so a user can create or edit a

4DGL Include file, 4DGL Library file, a Function or System file. These can then be included in the users 4DGL

code.

Heme [~ Tools

HE= « o0

%1 |4/ apeL reiatea

HEXROB c«O00.6 L OO %

New Open Save SaveAs  Print Cut  Copy Paste Delete | Undo Redo | ClearAll Next Prev Find Replace Goto  Find Again
File Clipboard Undo/Redo Bookmarks Find
. ap
[E [x] { [x] [ﬂ x| NoNamed.inc™ [ 3N

Insert Line:l Coll

© 2013 4D SYSTEMS

Page 14 of 37
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4D SYSTEMS

Workshop 4 User Guide

4.6. Create Text File

Create
Text
File

The Create Text File environment features a plain editor, suitable for writing basic documentation, application

notes, data files or anything else requiring plain text files.

orkshop 4 - Nohameb.od:

File Home [~ Tools

/\

Ldid= A X OB 5065 1LOO
New ﬂpen Save SaveAs Print | Cut Copy Paste Delete | Undo Redo | ClearAll Next Prev Find Replace Goto FmdAgam

File Clipboard Undo/Redo Bockmarks Find

qb

[E x] { ] [ﬂ x] [ [ | NoMames. bet* [x]
%1 |7/ other
Insert Linel Cold

© 2013 4D SYSTEMS Page 15 of 37
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5. Common File Menu

The File Menu is the first menu and common to all environments...

= Workshop 4 - NoName2(uLCD-32PT, LANDSCAPE) E@E
g Home  View| Tools Widgets Comms Project &
| New
=
Recent
\ | open SOUNDPLAYER.4DGenie 14/09/2012 12:32 p.m.
Bc:\ngramDa!a\Dnmments\4DLabs\PIO\SO\ns\
- Genie\SOUNDPLAYER\SOUNDPLAYER.4DGenie:
|
FANCYBUTTONS.4DVisi 21/12/2011 1:30 pm.
save

C:\ProgramData\Documents\4D Labs\PICASD 4D-
Visi\FANCYBUTTONS.4DViS

Noame1®

IMAGECONTROLKBD.4DG 22/10/20123:42 p.m.

=
L

-‘_B Zip Project
m C:\ProgramData\Documents\4D Labs\PICASO GFX2\PICASO- SERIAL

1 COMMS\BUFFEREDTX.4DG
lugh o= WORKSHOP  vesiniozi -
COMCHECK.4DG §/06/2010 1:41 am.

& Print Setup C:\ProgramData\Documents\4D Labs\PICASO GFX2\PICASO - SERIAL

‘ COMMS\COMCHECK.4DG

A biin Create a new Project SLIDETRACK.4DViSi 8/11/2012 1:50 p.m.
Start building a new Visi, Genie, Designer
or Serial program

C:\ProgramData\Documents\4D Labs\Picaso Designer|PICASO - MAGE
CONTROL\IMAGECONTROLKBDADG

BUFFEREDTX.4DG 6/06/2010 1:33 am.

C:\ProgramData\Documents\4D Labs\Picaso Visi\SLIDETRACKSDVIS

)

';2’ Spfere SWITCHANDKNOB.4DViSi 11/11/2011 5:52 p.m.
C:\Users\Public\Documents\4D Labs\Fcaso

@ Help Visi\SWITCHANDKNOB.4DViS

MP3-Player.4DVisi

@ e Create a new Project .

Start building a new program using the
same settings as you last used (Visi

x it uLCD-32PT) FANCYBUTTONS.4DViSi

C:\ProgramData\Documents\4D Labs\Paaso
Visi\FANCYBUTTONS.4DViS

4/11/2012 1:34 p.m.

abs\Picaso Visi\MP3-F

21/12/2011 1:30 p.m.

MP3-Player.4DViSi 4/11/2012 1:34 p.m.

...with various buttons relating to the project that is open (or greyed out if no project is open):

. File-related buttons,
. Print-related buttons,
. And miscellaneous buttons, such as Help, Options and Samples.

5.1. File-Related Buttons

The buttons include all the actions related to projects: New, Open, Recent, Save, Save As, Zip Project and Close
project.
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l& Close
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The options include:

o Click New to create a new project. A dialogue window asks for the screen and the kind of project.

CHOOSE YOUR PRODUCT

HOLED-96-G2
0.96" Intelligent OLED module

HOLED-128-G2 128x128
1.5" Intelligent OLED module

HOLED-160-G2 128x160
1.7" Intelligent OLED module

1.44" IntelligentLCD Module

HLCD-24PT 240x320
2.4"QVGA Intelligent Touch Screen LCD Module

HLCD-24PTU 240x320
2.4"QVGA Intelligent Touch Screen LCD Module

HLCD-28PT 240x320
2.8"QVGA Intelligent Touch Screen LCD Module

‘ HLCD-144-G2 128x128

£ x

-"-_\. -~ |. * 4D-AM-1002-VG Getting... » AMN2 Getting Started - Search ANZ Getting Started 2

Organize » New folder

i Mame Date modified

30 Favorites
Bl Desktop @ AN2 Getting Started 05/10,/2012 12:09 4DGENIE File
4 Downloads
3# Dropbox
%‘.._—_l Recent Places
& SkyDrive
TV enregistrée
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kY,
|
g

- Libraries
il 4D Systems
@ Documents
J’ Music
[ Pictures
B videos ~ ||

File name: AMNZ Getting Started - ’Visi Genie projects

l Open |VI l Cancel

Select ViSi-Genie projects among the different kinds listed below to load a ViSi-Genie project:

|‘|.|"ir5i| Genie Erﬂ'ﬁ vl
Designer projects
Wiz projects
B 4DGL Misc files
All files
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o Click Recent to list the recently accessed files, and click on the project to open it.
== Workshop 4 - NoName2(uLCD-32PT, LANDSCAPE) [E=SEEES)
Eg Home View Tools Widgis Comms  Project o
] e

Recent

|/ open SOUNDPLAYER.4DGenie 140972012 12:32 p.m.
B C:\ProgramData\Documents\4D Labs\PICASD Visi
- Genie\SOUNDPLAYER\SOUNDPLAYER.4DGenie
!
FANCYBUTTONS.4DViSi 24/12/2011 1:30 pam.
P :\ProgramData\Documents\4D Labs\PICASO 4D-
T i5i\FANCYBUTTONS 4DViS

IMAGECONTROLKBD.4DG 22/10/2012 3:42 p.m.

:

1_“ 2ip Project
C:\ProgramData\Documents\4D Labs\PICASO GFX2\PICASO - SERIAL

l& Close Wo R KS H o P Version 4.0:2.1 COMMS\BUFFEREDTX.4DG

COMCHECK.4DG
&, pint setup

c: b\ ICASD - IMAGE
CONTROL\IMAGECONTROLKEDADG

BUFFEREDTX.4DG 6/06/2010 1:33 am.

6/06/2010 1:41 am.

m C:\ProgramData\Documents\4D Labs|\PICASO GFX2\PICASO - SERIAL.
COMMS\COMCHECK.4DG

A Print Z Create a new Project SLIDETRACK.4DViSi 8/11/2012 1:50 p.m.
' ’ Start building a new Visi, Genie, Designer o
3 or Serial program c abs\Picaso Visi\SL
2
-.g’ (s SWITCHANDKNOB.4DViSi 11/11/20115:52 pum.
¥4 crusersipublicoocuments\io Labsaso
@ Help Visi\SWITCHANDKNOB.4DViS
= MP3-PL . 4DViSi Y11/ 1 .m.
) smo Create a new Project i i
npies Start building a new program using the c:\ngramuaxa\ommms\w Labs\Picaso Visi\MP3-Player4DViS
same settings as you last used (Visi
x Exit § uLCD-32PT) FANCYBUTTONS.4DViSi 21/12/2011 1:30 p.m.
C:\ProgramDilH\Dnmments\#DLabs‘Pﬁso
Visi\FANCYBUTTONS.4DViS
MP3-Player.4DViSi 4/11/2012 1:34 p.m.
o Click Save to save the modified projects.
. Click Save As to create a copy of already saved project and give it a new name. A standard Save

window opens and asks for the location and the name:

Search ANZ Getting Started 2

-
Organize * MNew folder 4= - (7]
e e *  Name Date modified Type

Bl Desktop | AN2 Getting Started 05/10/201212:09 4DGENIE File

& Downloads

%+ Dropbox
“El Recent Places
& SkyDrive
TV enregistrée

Y
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- Libraries
4D Systems
@ Documents

J’ Music AR [I[} +
File name: AN2 Getting Started -
Save as type: ’Visi Genie projects v]

~ Hide Folders ’ Save ] ’ Cancel ]

e Click Zip Project to make a compressed file out of the project. This is especially useful when then
project is large and contains pictures and videos.
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e Click Close to close the current project. You will be prompted to save the changes to any modified
project.

. | Save Changes to AN4 - Customised keyboard 4DGenie?

L3 ” Cancel ]

5.2. Print-Related Buttons

The buttons include all the actions related to print:

Prirter

Mame: [I'H'Iicmsnﬂ #P5 Document Writer

Status: Ready

Type: Microsoft XPS Documert Wiiter
Where:  XP5Port:

Commert:

Paper Orientation

Size: [M i@ Portrait

Source: [MumaticaII}rSEIect (7 Landscape

Y
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n
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kY,
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ok [Cas
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Click Print to print the project:

Prirter

Mame: [I'u'licmsnﬂ ¥P5 Document Writer

Status: Ready

Type: Microsoft XPS Document Whiter
Where:  XP5Port:

Commert:

Prirt range Copies
i@ Al Mumber of copies:

(") Pages  from: 1

() Selection | _ﬂﬂ —2}3 —3}3 Collate

AV
0
S oK || Cancel |
| -
\Y) 5.3. Miscellaneous Buttons
n
D The Miscellaneous buttons include Options, Help, Samples and Exit.
N
Q
0O
L
n
Y4
| -
g
L o= S il
—’J sy [ofcediue v e
LRl -- =
24l
&, print setup L LI
siem |
@
6 s
R
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Options include three panes but only Environment is relevant with ViSi-Genie, which is code-less. The Compiler
and Editor panes deal with code.

Environment | Compiler Editor

Reopen Files Image [ Video Resample Quality
@) Fastest
¥ Show Hints Birestes
7)) Scaled
Save as Opens Both ) Box
Backup Files (71 Spline
() Bilinear
() Bicubic
Style: [DFﬁceZ[Jll:)Blue - (7 Lanczos
Tab Color ]

Select the Style among different possibilities.
The Image / Video Resample Quality selection brings different options:

Fastest
Scaled
Box
Spline
Bilinear
Bicubic
o Llanczos
Click Help to access help, with links to the 4D Systems website:

o O O O O O

Workshop 4 User Guide

To access the 4D systems home page

Workshop 4
= Version: 4.0.2.1
e Copyright: 2012 4D Systems

For Peer help and support
1_[:] Zip Project
qp ose For manuals and other documentation visit the
downloads tab on the page for your product
Y, print setup
‘ Dt To report documentation errors and other hardware or
software issues send an email to support
" Options
B 4

Also see the Samples item for the location of various samples.

@ Samples
x Exit
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Click Samples to access examples from 4D Systems, with pre-defined filters:

SAMPLES

Samples were loaded onto your hard drive as part of the installation
process for Workshop

44D Labs - Click to browse all files
-~ Goldelox Designer - Click for filtered browse
- Goldelox Visi - Click for filtered browse

- Picaso Designer - Click for filtered browse
- Picaso ViSi - Click for filtered browse
- Picaso ViSi Genie - Click for filtered browse

4D has a codebase of useful code and
snippets that may come in handy

The 4D website contains a host of application
notes

Also see the Help item for the location of various help information.

9 o=

Click Exit to close Workshop 4. You will be prompted to save the changes to any modified project.

@ Save Changes to AN4 - Customised keyboard 4DGenie?

[ Yes Mo H Cancel l

6. Designer Specific Menus

The Designer environment includes five menus:

6.1. Home Menu

The Home menu is the main menu...

=1 - .- Workshop 4 - NoNamel (uLCD-32PT, LANDSCAPE) ———— T
. - — R -
File Home View Tools Widgets Comms Project a
LU A3 5005100 B I 9 0
= Wb Ageas Bireste | @Redo 6 <) ‘ A | Zepandal y
New  Open Cut ClearAll  Next Prev Set Find Replace Goto Find Again Compile Comp'nLoad
& Print Delete
File Clipb§rd Undo/... Bookmarks Find Code Folding Compile

...with three groups of buttons:

. File-related commands,
. Build command,
. And the objects pane.

6.1.1. File-Related Buttons

The file-related buttons include the same commands as seen in the File menu: New, Open, Save, Save As and
Print.
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= | L E Save

= E Save As
M ew Open
_ & Print
File

6.1.2. Code Related-Buttons

The code related buttons include the standard Windows commands of Cut, Copy, Paste, Delete, Undo and
Redo.

# W Copy &S undo
_m, Paste @ Redo

Delete
Clipboard Unda/...

6.1.3. Bookmark Buttons

The bookmark buttons include Set a bookmark, go to Next or Previous bookmark and Clear All bookmarks.

% © 0 s

Clear &ll  Mext Prev Set

Cut

Bookmarks

Bookmarks are shown close to the line number:

=]
L L L

[FR T L

Bookmarks are especially useful for large projects.

6.1.4. Find and Replace Buttons

The find and replace buttons provide the basic features for code.

L OO K

Find Replace Goto Find Again

Find
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The Find button prompts for a string and highly it in the code:

I
[
s

m

28 |"NoNamel.dan", "NoNamel.gcn"™, 1); // Open handle to access uSD fonts, uncc
®2 |xf", 'r') : // Open handle to access uSD strings, [Hfdewdges 1f required

-

1 letamst Ast" MNANams? meit T
L] [ [ | 3

|

uncomment v & £ @ [Jwholewords [7]Case Sensitive @ This file () Files in proj

|

Use the up and down arrows to look for the previous and next occurrence. Check Whole Words and Case
Sensitive. Choose between This file and Files in progress and All Open Files.

F

@ This file () Files in project ) All open files

The Replace button searches for a string and exchanges it with another string:

1 |#platform "uLCD-32PT_GFX2"

| »

// Program Skeleton 1.0 generated 15/10/2012 14:27:3

Lo

m

5 |#inherit "4DGL_l1ébitColours.fnc"
#inherit "VisualConst.inc"
2 |#inherit "NoNamelConst.inc"

11 |func main|()

1St rIn K Handle t coe uSD string uncomment 1f reguire
/4 war hstrings /4 Handle te access D strings, uncomment 1f required
/4 war hFontx ; /¢4 Handle to access ufD fonts, uncomment 1f reguirsd an
14 |// Inecomment the fallawing 1f nSh imad=s. fants ar strings nsed. e
€| 1 | 3
|
uncomment v & £  [Jwholewords [7]Case Sensitive (@ This file () Files in proj

Y
=
5
i8]
| -
U
n
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I
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C
0
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- Jﬁeplace @Replaoe all

Same options as for Find apply.

The Goto button prompts for a line number:

Goto Line A g

Mew Line?
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6.1.5. Code Folding Buttons

The code folding buttons allow to collapse or expand a function:

Collapseal

—
pr—
—

Expand All

Code Felding

This is especially useful for large projects.

6.1.6. Compile Buttons

The Compile button launches the compilation of the project while the Comp’nLoad compiles and uploads the

&% O

Compile Comp'nLoad

project to the screen.

Compile

6.2. Menu Tools

I:Ei:l (al Terminal 115200
.+°]

—'l 15 1 i
Graghies  Pmme  Terminal ﬁTnuu:h Calibration
Composs  Loader 9600 9 4DGL uVGA Link

All the tools and utilities are grouped here:

. Click PmmC Loader to start the PmmC Loader utility.

o Click ‘Terminal connect 9600’ to open the currently selected com port at 9600 baud in the
Terminal program.

o Click ‘Terminal connect 115200’ to open the currently selected com port at 115200 baud in the
Terminal program.

o Click Touch Calibration to calibrate the touch on the display.

. Click 4DGL uVGA Link to open a window which can interact with the uVGA, enabling a mouse and

keyboard to be used with the uVGA(GFX) module. Demo code is available from Workshop 4.

6.3. Comms Menu

This menu is in charge of the communication port:

(| = '
Home View Tools Widgets Comms  Project
Status at 14:27:36
comMz2y - ) © a. -
Device is not responding

Comms

The use of this menu is described at the section
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Connect the .

6.4. Project Menu

The Project menu includes different parameters and options...

[ ==

Fle ' Home View

Flash

|nn [ R

Destination | Display

...with two groups of buttons:

. Destination,
. And display selection.

6.4.1. Destination

The first group includes the options for the destination:

EA g Eai]
R&M | Flash

Destination

Select the Destination among two possibilities:

e RAM means the display must be connected curing build and that the program will be downloaded to
the display’s RAM memory once compiled.

e  Flash means the display must be connected curing build and that the program will be downloaded to
the display’s flash memory once compiled.
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6.4.2. Display Selection

The second section allows to select the screen. Clicking on the button...

uLCD-32PT
LANDSCAPE =

Display

...opens a new window to select the screen:

O

Orientation
(" Portrait

(@) Landscape

|| Portrait Reversed

(") Landscape Reversed

Select the screen from the drop-down list:

luLco-32pT - |
uLCD-24PT A
uLCD-24PTU —
uLCD-28PT -
uLCD-28PTU
uLCD-32032-P1
uLCD-32PT
uLCD-32PTU
uLCD-32WPTU -

Define the orientation among the four options:
Orientation
[ Portrait
'@ Landscape
|| Portrait Reversed
(I Landscape Reversed

Confirm by clicking on or deny by clicking on .
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7. ViSi Specific Menus

The ViSi environment includes all the menus available with the Designer environment plus two additional

- ——
‘m Home View Tools Widgets Comms Project

menus: View and Widgets.

7.1. View Menu

The View menu includes one important tool for visualising the form:

©O06e9

Object cnonahor et Object
Inspector orm NapSNot ey Loctions

Possibly hidden Forms

Click on Snapshot to open a specific window of the form to enable a 1:1 screenshot of the display to me made.

@Snapshot I - |.‘:' =l PS I
Zoom

This window provides a zoom up to 4 times. The Save button allows to save the screen as an image.

Object Inspector, Form, and Reset View, all relate to the menus and tool bars used in Workshop 4. These
toolbars and menus can be moved and detached from the side of Workshop 4. Object Inspector and Form will
bring to front the relevant toolbar when clicked. If required, the toolbars can be reset back to their default
location by clicking the Reset View button.

Object Locations enables the user to copy the locations/coordinates of objects on the display, to the clipboard.
7.2. Widgets Menu

The Widgets menu includes the objects pane with all the objects available to build the interface:

| E = Workshop 4 - NoNamel (ult
ﬁ Home View Tools Widgets| Comms Project
|Buttons  Digits  Gauges  Primitves  Inpuls  Lebel  SystemMedia @

By

The objects —also called widgets—are detailed in the ViSi User Guide.

© 2013 4D SYSTEMS Page 28 of 37 www.4dsystems.com.au



Y
=
5
i8]
| -
U
n
-]
T
al
a)
C
0
kY,
|
g

40 SYSTEMS Workshop 4 User Guide

8. ViSi-Genie Specific Menus

ViSi-Genie includes five menus with specific ribbons and options.

o -
y o
m Home View Tools Comms Project

ViSi-Genie is codeless and thus completely different from the previous code-based environments, all the menus

relating to ViSi-Genie are detailed.

8.1. Home Menu

The Home menu is the main menu...

=l - \blorkshop‘l ‘ ]
- .
ECMN | Home View Tools Comms Project

B i E L—E = & [Buttons  Digits  Gauges  Primtves  Inputs ' Labek  System/Meda
New Open Save SaveAs Print Build

Y I3%

File | Build

...with three groups of buttons:

. File-related commands,
. Build command,
o And the objects pane.

8.1.1. File-Related Buttons

The file-related buttons include the same commands as seen in the File menu: New, Open, Save, Save As and

Print.
lH G-

Mew Cpen Save Save Az Print

File

8.1.2. Build Button

The Build button launches the compilation and the upload of the project to the screen.

Build

8.1.3. Objects Pane

The objects pane includes all the objects available to build the interface:

|Buttons  Digits  Gauges  Primtves  Inputs  Llabels  System/Media
Y 1%

The objects are detailed on the ViSi-Genie User Guide.
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8.2. View Menu

The View menu includes one important tool for visualising the form:

0066

-
Object Reset Object
Inspector Form  Snapshot view Locations

Possibly hidden Forms

Click on Snapshot to open a specific window of the form.

-
4 Snapshot

This window provides a zoom up to 4 times. The Save button allows to save the screen as an image.

8.3. Menu Tools

B @ EEJ] [¥9 Terminal 115200 " GTX

(4 = = S
Boot PmmC Terminal ¥ Touch Calibration

SO Loader 9600 o
g paasr % 4DGL WGA Link

All the tools and utilities are grouped here:

Click Boot uSD to upload the boot-loader to the screen.

Click PmmC Loader to start the PmmC Loader utility.

Click ‘Terminal connect 9600’ to open the currently selected com port at 9600 baud in the
Terminal program.

Click ‘Terminal connect 115200’ to open the currently selected com port at 115200 baud in the
Terminal program.

Click Touch Calibration to calibrate the touch on the screen.

Click 4DGL uVGA Link to open an interactive window to use mouse/keyboard with the uVGA(GFX)
module.

Click GTX to launch the Genie Test Executor debugger.
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Clicking the GTX button, a new screen will appear with the form and objects defined in the project:

m —
Contral
ot G5 <] ElRmetanoen B RV
Active Form
i e
Meters
Query Values| 0 1B
Trackbars
Query values

8.4. Comms Menu

This menu is in charge of the communication port:

=\
Home View
Status at 17:52:11
CoM27 v 5@
Com port not currently
.. available

Comms

ools| Comms ™ Project

The use of this menu is described in section 9 “Connect the Module”

8.5. Project Menu

The Project menu includes different parameters and options...

Project
Destinati
vestnatien Comms Speed: 9600 - - uLCD-24FTU
” Flash ” Run Flash ” ush : e
Sound Buffer: 1024 -
Genie Display

...with three groups of buttons:

. Options for Genie,
. Parameters,
. And display selection.
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8.5.1. Genie Options

The first group includes the options for Genie:

Destination

” Flash m Run Flash m usD

e Select the Destination among three possibilities:
o Flash - The display must be connected during Build and the program will be downloaded to
the display’s flash memory once compiled. The users application will be stored in Flash, but

will be run from RAM.

o Run Flash - The display must be connected during Build and the program will be downloaded
to the display’s flash memory once compiled. The users application will be stored and run
from flash, this uses less memory on the display, but makes programs run slightly slower.

o uSD - The users application will be built and copied to the uSD card to be run from there. This
option requires the Boot uSD program to be uploaded to the display’s flash, as seen in the
menu Tools. This Boot uSD program loads the users application from the uSD card at startup,
and executes it.

e

Boot
usD

8.5.2. Parameters

The second group include advanced parameters:

Comms Speed: 9600 -

Sound Buffer: 1024 -

e Comms speed Is the baud rate at which the serial command interface operates

e Define Sound buffer size for the amount of memory set aside for buffering wav (sound) files. For
simple sound files 1024 bytes should be enough. For complicate sound files to be played whilst video
is displaying may need as much as 4096 bytes.
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8.5.3. Display Selection

The last section allows selecting the screen, useful for converting a program from one display module to
another. Clicking on the button...

...opens a new window to select the screen:

Orientation

("1 Portrait

) Landscape

|| Portrait Reversed

1 Landscape Reversed

Select the screen from the drop-down list:

luLcp-32rT - |
uLCD-24PT n
uLCD-24PTU —
uLCD-28PT .
uLCD-28PTU
uLCD-32032-P1
uLCD-32PTU
uLCD-32WPTU -

Define the orientation among the four options:
Orientation
[ Portrait
'@ Landscape
[ Portrait Reversed
[ Landscape Reversed

Confirm by clicking on or deny by clicking on .
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9. Connect the Module

Connect the module to a USB port with the 4D Systems programming cable and select the Comms menu:

SR N————
Home View Tools Comms Project

Above the Comms section, the violet light mentions no module is currently connected.

[—T] Please select an

... available port

Comms

Connect the 4D Systems programming cable/adaptor to the module and plug the cable into the USB port.
Click on the drop-down list and select the COM port relating to the 4D Programming cable/adaptor.

| %= | =
)ﬁ Home Wiew Tools Cormms  Project
||
-
h—l Please select an
| * :
| comss available port
i comMig | _
Il comzo |5|| Comms
COM21
COomM22 )
COM23 wchanging onChanged [x]
COoM24 ™
o
[ 1 ‘I |f_\ I
The light turns while the connection is being established:

Status at 11:39:02
comMms - = .
Scanning Port

Comms

Finally, the light goes blue when the connection is established.

Status at 11:34:00
coM3
uLCD-32PT [v3.0]
% (uSD: 1,36 GE)

Comms

The light turns red when no module is attached to the selected port:

Status at 12:24: 18
COM2Y
The system cannot find
... the file specified

Comms
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10. Insert the Micro-SD Card

The Picaso modules, micro-SD card shall be FAT16-formatted. Partition can't exceed 4 GB.

For Goldelox modules, the micro-SD card shall not be formatted at all, it requires the SD card to be RAW.

To connect the micro-SD card, either

e Insert the micro-SD card into the USB adaptor and plug the USB adaptor into an USB port of the PC.

Or

e Insert the micro-SD card into a micro-SD to SD card converter and plug the SD card converter into the
SD card slot of the PC.

Check the micro-SD card is mounted, here as drive E:.

@_Ov 1% b Computer » ~ | ég | search Camputer )
i
Organize »  AutoPlay  Eject  Properties  System properties  Uninstall or change a program ~ » BE- 1 @
't Favorites 4 Hard Disk Drives (2) i
| Local Disk (C:) Recovery (D)
4 Libraries w - | = —
591 GB free of 676 GB S0 528 GB e of 21,4 6B
& Homegroup 4 Devices with Removable Storage (2)
£ Removable Disk (F:)
18 Computer $ DVD RW Drive (E) -
' = W 155 G free of 186 G5
&, Local Disk (C) - : L=t
(a Recovery (D:)
= Removable Disk (F:)
€ Network
Removable Disk (F) Space used: | | Total size: 1,85 GB
W7 FRemovable Disk Space free: 1,85 GB File system: FAT

For Goldelox, if prompted to format the SD card, click no/cancel. Leave the card unformatted and Workshop4
will handle the rest.
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12. Legal Notice

Proprietary Information

The information contained in this document is the property of 4D Systems Pty. Ltd. and may be the subject of
patents pending or granted, and must not be copied or disclosed without prior written permission.

4D Systems endeavours to ensure that the information in this document is correct and fairly stated but does
not accept liability for any error or omission. The development of 4D Systems products and services is
continuous and published information may not be up to date. It is important to check the current position with
4D Systems. 4D Systems reserves the right to modify, update or makes changes to Specifications or written
material without prior notice at any time.

All trademarks belong to their respective owners and are recognised and acknowledged.

Disclaimer of Warranties & Limitation of Liability

4D Systems makes no warranty, either expressed or implied with respect to any product, and specifically
disclaims all other warranties, including, without limitation, warranties for merchantability, non-infringement
and fitness for any particular purpose.

Information contained in this publication regarding device applications and the like is provided only for your
convenience and may be superseded by updates. It is your responsibility to ensure that your application meets
with your specifications.

Images and graphics used throughout this document are for illustrative purposes only. All images and graphics
used are possible to be displayed on the 4D Systems range of products, however the quality may vary.

In no event shall 4D Systems be liable to the buyer or to any third party for any indirect, incidental, special,
consequential, punitive or exemplary damages (including without limitation lost profits, lost savings, or loss of
business opportunity) arising out of or relating to any product or service provided or to be provided by 4D
Systems, or the use or inability to use the same, even if 4D Systems has been advised of the possibility of such
damages.

4D Systems products are not fault tolerant nor designed, manufactured or intended for use or resale as on line
control equipment in hazardous environments requiring fail — safe performance, such as in the operation of
nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines
or weapons systems in which the failure of the product could lead directly to death, personal injury or severe
physical or environmental damage (‘High Risk Activities’). 4D Systems and its suppliers specifically disclaim
any expressed or implied warranty of fitness for High Risk Activities.

Use of 4D Systems’ products and devices in 'High Risk Activities' and in any other application is entirely at the
buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless 4D Systems from any and all
damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any 4D Systems intellectual property rights.

13. Contact Information

For Technical Support: support@4dsystems.com.au
For Sales Support: sales@4dsystems.com.au

Website: www.4dsystems.com.au

Copyright 4D Systems Pty. Ltd. 2000-2013.
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